
Using the Mwave Audio Function 

Note: 

Using the Audio Function for Windows 

f"c.71 ~ ~ To use Mwave audio in Windows, open an audio application such as 
~ ~ ~ Media Player or Sound Recorder in the Windows Accessories 

group. 

To use the Mwave audio features in To control the audio input or output, do the following: 

WIN-OSQ, install the Mwave DSP 1 Select Mwave ThinkPad from Windows. 
support software for Windows in the 
full screen WIN-OSQ session . 2 Select Audio Control. The following windows appears: 

To install the Mwave DSP support 
software: 

Chapter 7. 

Controls Viewed· 
GAMES , IIWAVE MASTER! 1...1!".@)Lll ■ ( Record I 

Treb le Bass 

O Tone Control 

:-.J:"": r. ' -:J;-: 
I Mute ~ I Mute I I Mute JI 

l l 0
-~ 

Chorus Reverb 

O Effects 

This window allows you to maintain control over volume, balance, 
tone, and effects for all audio components and input sources. For 
more information, see Mwave Help in the Mwave ThinkPad window. 

Using the Audio Function for DOS 

The Mwave feature supports audio for DOS games through Sound 
Blaster support. 

To enable Sound Blaster support for DOS games: 

1 Type FASTCFG at the command prompt; then press Enter. 

The FASTCFG utility opens. 

2 Select Games; then select OK. 
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ThinkPad Features program: 

Page 35. 

Using the Mwave Audio Function 

Solving a Memory Shortage Problem for Your Games 

If you do not have enough memory for your games, you should 
make a boot diskette before starting the DOS games. To make a 
boot diskette, do the following : 

1 Start DOS and insert a blank diskette into the diskette drive. 

2 Type MAKEBOOT at the DOS prompt; then press Enter. 

A boot diskette is created. Before starting your games, restart 
the computer with this boot diskette inserted in the diskette 
drive. 

Some sample files, such as the CONFIG.SYS file , are created on 
the boot diskette. You might need to modify these files by referring 
to the manuals that came with your games. 

Default Values for DOS Games Audio 

Most games automatically determine the 10 address, interrupt level 
{RQ), and OMA channel settings for the audio for DOS games. If 
the game asks for this information, specify the default settings for 
Sound Blaster as follows: 

10 Address 
IRQ 
DMA Channel 

220 
5 

If you need to change these settings, use the ThinkPad Features 
program. 
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Using the Mwave Telephony Function 

Using the Telephony Function 

Note: 
In some countries, the Mwave 
telephony functions are only 
available with the DAMelephony Kit 
option installed . To install a 
DAMelephony Kit on the computer, 
see "Installing the DAMelephony 
Kit" on page 149 and the 
documentation that came with the 
option. 

The computer is equipped with a modemfax port on its side that 
connects a telephone cable. This section describes how to connect 
the cable to the computer, and it describes the telephony features 
that can be used for communication. 

Note -----------------------, 

Non-US. users must run the Country Selection program (~ ) in 
the Mwave window after the Mwave installation is complete. 
pee page 58) 

CAUTION: 
Your computer can use only a public-switched telephone 
network f>STN). Do not use a PBX private branch exchange) 
or other digital telephone extension lines. Use of phone lines 
other than PSTN can damage your modem. If you are not sure 
which kind of phone line you are using, contact your telephone 
company. Many hotels or office buildings use digital telephone 
extension lines, so check before connecting the telephone 
cable in such places. 

To use the telephony functions, you need to connect a telephone line 
to your computer. 

~DANGER 

To avoid shock hazard, do not connect the cable to or 
disconnect the cable from the telephone outlet on the 
wall during electrical storms. 

56 IBM ThinkPad 760E, 760ED, or 760EL User's Guide 

GOOGLE EXHIBIT 1037 
GOOGLE v. NEONODE 

IPR2021-01041
Page 74 of 127



Note: 
If you use both the computer and a 
telephone with one telephone cable, 
use the telephone cable supplied 
with your computer. 

If you use the DAA7relephony Kit 
(available as an option), see page 
151 . 

Using the Mwave Telephony Function 

When your computer has a modemfax port with a square 
receptacle, first connect the ferrite-core end (connector 1 ) of the 
telephone cable to the modemfax port; then connect the other end 
( 2 ) to the telephone outlet on the wall. 

Important ------------------~ 

Make sure you use the correct telephone line so your modem 
operates correctly. When you are: 

At home: Use an analog line, a standard household 
telephone. 

In your omce: Use a line connected to a fax machine or 
another modem. 

In a hotel: Request a room with a data or normal telephone 
line. 

Your RJ11 jack must be wired for an analog line. If you are not 
sure what type of line you are connecting, check with the 
telephone company. 

Using the Modem with 0S2 

To start the Mwave modem with 0S2 Warp, do the following : 

1 Open the Mwave ThinkPad folder. 

2 Double-click on the Mwave Modem icon. 

The Mwave modem starts automatically. 

3 Start your communication program. 
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Using the Mwave Telephony Function 

Using the Modem with DOS 

To start the Mwave modem with DOS, do the following: 

1 Type FASTCFG at the DOS prompt; then press Enter. 

The FASTCFG utility opens. 

2 Select Advanced Modem; then select OK. 

3 Start your communication program. 

Using the Modem with Windows 

When you start Windows, the Mwave modem automatically starts 
and will be ready to use. 

Using Country Selection 

Important ------------------~ 

Each country has restrictions on communication that uses 
telephone lines. Use this window whenever you travel to other 
countries. 

The Country Selection window allows you to change the country 
name currently supported by the Mwave telephony features. When 
you travel to other countries and use the Mwave telephony function, 
you need to select the country name from the list of countries in this 
window. 
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Using the ESS AudioDrive Sound feature 

Using the ESS AudioDrive Sound feature 

Note: 

~ This section provides information about the audio functions 
ESS supported by the ESS AudioDrive Sound feature. The ESS 

AudioDrive supports for Sound Blaster Pro applications. 

Do not enter suspend mode when 
using the audio functions. 

Using the Audio Function for OSP 

The ESS AudioDrive feature supports audio in the 0S2 environment 
through the Multimedia Presentation Manager2 l\,'1MPM2). To use 
the ESS AudioDrive functions with 0S2, open the Multimedia folder 
from the 0S2 desktop. 

Using the Audio Function for Windows 

To use ESS AudioDrive in Windows, click on the Audio 
Applications icon in the Main Program group. The following screen 
appears: 

Audio Applications 

fl ■ Ii Volume Control Mixer Recording 
Control 
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Using the MIDI/Joystick Port 

Using the MIDI/Joystick Port 

The Enhanced Video model provides a MIDIJoystick port on the rear 
of the computer for MIDI (nusical instrument digital interface) 
equipment or a joystick for playing games. A MIDIJoystick cable is 
supplied with the computer to connect a joystick. When connecting 
MIDI equipment, you have to purchase a MIDI connector to connect 
musical instruments with MIDI ports. 

To attach the MIDIJoystick cable to the computer: 

1 Turn off the computer and connect the MIDIJoystick cable to 
the computer as shown: 

2 Connect the other side of the cable to a MINI-DIN cable or a 
connector that connects to your MIDI equipment or joystick. 

3 Enable the MIDIJoystick port using the ThinkPad Features 
program: 

a) Start the ThinkPad Features program. 

b) Select the MIDI/joystick ( ) icon. 

c) Click on Enable for MIDI or joystick; then click on OK. 

d) Restart the computer. 
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How to Attach a Television to the Computer 

Attaching a Television to the Computer 

~ You can attach a television (NTSC or PAL) to the computer and 
display the computer output on it. 

To display the computer output on the attached television, do the 
following: 

1 Attach the television to the computer as follows: 

a) Turn off the computer and television. 

b) Connect the video in-out cable 2 to the video-out port 
(□) 1 at the left side of the computer; then connect your 
television. 

v;deo In 1' n;Aud;o-ln Le~ 

S-V;deo In I \- ~ud;o-ln R;~ht 

Ir\~ ol/7 ) 4 - ,..--,.,,.~ 
~of. y 

~/ 
wr 

To headphone jack 
of the computer 

Cables, except for the video in-out cable 2 , are not 
supplied with the computer. 

If you are using video equipment with S-video input, 
connect the S-video port of the video in-out cable to the 
S-video-in connector of your video equipment ( A ) for 
better picture quality. 
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How to Attach a Television to the Computer 

If you are not using video equipment with S-video input, 
connect the composite video port of the video in-out 
cable and the video-in connector of your video 
equipment ( B ). 

If your video equipment has only one audio input 
connector, use the left-audio connector on the audio 
cable. 

2 Enable the video-out port: 

a) Start the ThinkPad Features program. and select the 

Enhanced Video ( ) icon. 

b) Click on Enable Video-Out. 

Note --------------------, 

Do not select Enable Video-out in the ThinkPad 

Features program's Enhanced video ( ) screen, 
unless you have attached a television to the computer. 

Otherwise, the LCD screen becomes blank. In this 
case, use the Fn+F7 keys to restore the LCD screen. 

3 Select the appropriate television color standard: NTSC (default) 
or PAL. To do this, start the ThinkPad Features program and 

select the Enhanced video ( ~·~ ) icon; then select NTSC or 
PAL. 

4 Restart the computer to make the change effective, if you 
switch the color standard between NTSC and PAL. 

When you use a PAL television attached to the computer, you 
can select 800x600 and 640x480 resolution modes. When you 
use an NTSC television attached to the computer, you can 
select only 640x480 resolution mode. 
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Note: 
Even if you selected television 
output, whenever you turn on the 
computer, its output is always 
displayed first on the LCD. 

Note: 
You cannot display the computer 
output on the LCD and television at 
the same time. 

How to Attach a Television to the Computer 

Switching Output between the LCD and the Television 

When you attached a television to the computer, you can select 
where to display computer output using: 

The Fn+F7 keys. 

The ThinkPad Features program: 

CRT dQ) for the television 

- LCD ( li;;JI) for the LCD 

Entering a PS2 sc command from the command prompt. 

For 0S2 

When you use 0S2 on a television attached to the computer, do 
not switch between a full-screen session and an 0S2 
Presentation Manager (PM) session: Otherwise, the screen will 
black out or be corrupted. To avoid this, switch to the LCD using 
the Fn+F7 keys, before you go to the full-screen session or 
return to the PM session . And then switch to the television. 
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How to Attach a Television to the Computer 

Displaying Output on the External SVGA Monitor 

Note ---------------------~ 

You can attach both a television and an SVGA monitor to the 
computer; however, you can display the computer output on only 
one of the two at the same time. To switch between those two, 
you need to use the ThinkPad Features program. 

To display computer output on the attached external SVGA monitor 
after using the television, do the following: 

1 Turn off the computer and attach the SVGA monitor to the 
external-monitor connector at the rear of the computer. 

2 Turn on the computer and start the ThinkPad Features 
program. 

3 Click on the CRT d.Qb icon; then click on Enable External 
Display. 
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Using the Enhanced VideoMPEG Functions 

Using the Enhanced VideoMPEG Features 

The Enhanced Video feature provides the video overlaytapture and 
MPEG functions and video in-out port on the side of the computer to 
attach your home video equipment. It also provides the total image 
video with MPEG-1 and MPEG-2 HHR ~alt-horizontal resolution). 

With the Enhanced Video feature, you can take advantage of the 
following : 

MPEG playback: The MPEG playback viewer can play back 
many available CD-i movies, video CDs, and karaoke MPEG 
video titles. No DOSCD-i game titles are currently supported. 
MPEG2 titles are restricted to HHR at 4 Mbps. 

Video-in t,ideo capture): 

- Capture still images or motion video from the video-in port. 
- Overlay motion video from the video-in port. 

Video-out: To use the video-out function, see "Attaching a 
Television to the Computer" on page 61. 

When using the video overlaytapture and MPEG functions, keep the 
following in mind : 

You cannot enable or disable the Enhanced Video feature, or 
change from video-in to video-out, while the playback or capture 
window is open. Close the playback or capture window before 
you make changes. 

The MPEG playback and the video-in video capture) functions 
use the same hardware resources. Only one of the two 
functions can be used at the same time. For the same reason , 
two MPEG functions cannot be used at the same time. 
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Using the Enhanced VideoMPEG Functions 

Using the Video OverlayCapture and MPEG Functions for 
052 Warp 

This section describes how to use the video overlaytapture and 
MPEG functions in OSQ. 

You need at least 12MB of memory to play MPEG or to capture 
video from the video-in port using Video IN. 

When reinstalling the video overlaytapture and MPEG device 
drivers, install Video IN from the BonusPak, preloaded on the 
computer, prior to the device drivers. 

When the Enhanced Video feature is enabled by the ThinkPad 
Features program, and any of the following is being played or 
used, do not enter suspend mode: 

- AVI file 
- MPEG file 
- Video CD 
- CD-i 
- Video-in feature 

Make sure you close the application that plays any of these files 
before entering suspend mode. 

Using the MPEG Playback for 0S2 

To use MPEG playback function in OSQ, open the Multimedia 
folder and do one of the following : 

When you want to play MPEG files: 

1 Select the Digital Video 3 icon, and click on File on the 
tool bar. 

2 Select Open to specify the MPEG file name. 
3 Select OK. 
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Note: 
The Video CD Player program 
cannot play some video CDs. If you 
cannot play your video CD, click on 
the Digital Video 3 icon instead; 
then follow the instructions on the 
screen. 

Using the Enhanced VideoMPEG Functions 

When you want to play a video CDs or CD-i movies from the 
CD-ROM drive of your computer, select the Video CD Player 
icon. 

MPEG under WIN-0S2 

WIN-0S2 does not support the playing of MPEG files. 
When you select IBM MPEG-2, MPEG Video, or CD-iWideoCD 
in the Device Driver folder of Media Player, the following error 
message might appear: 

IBM MPEG : This driver can NOT be loaded under in-OS2 

When you click on Video CD Player, the following error 
message appears: 

Win32s Error . .. 

Ignore any error messages; then click on OK to exit the error 
message screen. 

The following shows considerations when using the MPEG playback 
in 0S2 Warp: 

When you run other tasks while an MPEG file is being played, 
the MPEG file image might be distorted temporarily. 

The bar displaying the running time for the video CD might not 
be exact. 

You cannot play two MPEG files at the same time. Also, you 
cannot play the MPEG file while using the video-in function. If 
you try to do this, the following error message is displayed: 

Unable to open device 'IBM MPEG-enh Vid 3', use the 
Multimedia Set up program t o ensure that the file 
is associated to a MMPM/2 dev ice . 

Using the Video-in Video Capture and Video Overlay) for OSIZ 
You can capture still images or motion video using video capture 
application Video IN supported by MMPM2, and the video-in port of 
the computer. 
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Using the Enhanced VideoMPEG Functions 

To capture motion video: 

1 Turn off the computer and connect the video in-out cable 2 to 
the video-in port (G) 1 of the computer; then connect your 
video equipment. 

Cables, except for the video in-out cable 2 , are not supplied 
with the computer. 

11 9'-

Video Out Audio-Out Left 

S-Video Out / /I r = Audio-Out Right 

Lo_ q_ j_JI / ~- ~,.~.,.====1V 

m Jl 
,,, 

To microphone jack 
of the computer 

If you are using video equipment with S-video output, 
connect the S-video port of the video in-out cable to the 
S-video-out connector of your video equipment A for 
better picture quality. 

If you are not using video equipment with S-video output, 
connect the composite video port of the video in-out cable 
and the video-out port of your video equipment B . 

If your video equipment has only one audio output 
connector, use the left-audio connector on the audio cable 
for connection. 

2 Check the Enhanced Video status. 

a) Open the ThinkPad Features program and select the 

Enhanced Video ( ) icon. 

68 IBM ThinkPad 760E, 760ED, or 760EL User's Guide 

GOOGLE EXHIBIT 1037 
GOOGLE v. NEONODE 

IPR2021-01041
Page 86 of 127



Using the Enhanced VideoMPEG Functions 

b) If Video captureMPEG status is enabled, go to step 4 on 
page 69. 

If not, continue to the next step. 

c) Click on Advanced; then click on the 1st IRQ list box and 
assign an IRQ for the device. (The default IRQ is 11 .) 

3 Restart the computer to make the IRQ setting take effect. 

4 Open the Multimedia folder in OS2. 

5 Click on the Video IN Recorder icon. 

For more information on how to use video-in function in OS2, 
use Help. 

Note -------------------~ 

When you use the video-in recorder in OS2, you can use 
only Ultimotion Real-Time Compression as the 
compression type. Other compression types are not 
supported even if they are listed on the screen. 

The following shows considerations when using the video-in feature 
or video capture in OS2: 

Only one capture window can be open at a time. 

Video-IN Recorder is an OS2 MMPM2 application for video 
capture and video overlay. Its video capture size (width and 
length) is limited to up to 320x240 pixels (for a NTSC video 
source) or 384x288 pixels (for a PAL video source). 

Also, largesize capture, for example, 640x480 for NTSC or over 
768x576 for PAL, might be not available with your computer. If 
you try capturing large images, the captured image will not look 
as expected, or the capture application will be suspended with 
the following error message: 

SWVR118: The recording initial ization fai l ed return code is 
5 8 - s y stem out o f memo r y 

If you have this error message, close Video-IN; then restart it. 
Before trying again , set the capture size to a smaller one. 
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Using the Enhanced VideoMPEG Functions 

Common Restrictions for Video CaptureDver/ay and MPEG 
Playback 

You must be aware of the following when using the video 
capturebverlay functions or the MPEG playback functions. 
Otherwise, the video image might not be visible on the computer 
screen or the television, or the computer might become locked up or 
suspended. In these cases, close the Video-IN Recorder or Digital 
Video Player and restart it, or restart the computer. 

You can use only one video application at a time-for example, 
you cannot capture video while playing back an MPEG file. If 
you use multiple applications, an error message appears on the 
screen and the computer might become locked up or suspended. 
In that case, restart the computer. 

Do not enter suspend mode while attempting video capture or 
overlay. 

Do not use the Enhanced Video functions $uch as capturing or 
overlaying video using the Video-IN Recorder, or playing back 
the MPEG files using the Digital Video Player) in the following 
display modes: 

- 1024x 768 resolution, 256 color depth, and 75Hz refresh rate 
- 1024x 768, 65;i36, and 75Hz 
- all 1280x1024 resolution mode 

Otherwise, the image might be corrupted. 

Do not select virtual screen in the ThinkPad Features program. 

Video overlay and capture are not supported in virtual screen 
mode, such as 1024x 768 on an LCD or 800x600 on a television. 
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Using the Enhanced VideoMPEG Functions 

Using the Video OverlayCapture and MPEG Functions for 
Windows 3.11 and Windows 95 

~ ~ This section describes how to use the video overlaytapture and 
~ ~ MPEG functions in Windows 3.11 and Windows 95. 

To use the MPEG playback in Windows 3. 11: See "Using the 
MPEG Playback for Windows 3.11 ." 

To use the MPEG playback in Windows 95: See "Using the 
MPEG Playback for Windows 95" on page 73. 

To use the video-in (tideo capture and overlay) in Windows 3. 11 
and Windows 95: See "Using the Video-in Video Capture and 
Video Overlay) for Windows 3.11 and Windows 95" on page 75. 

Using the MPEG Playback for Windows 3. 11 

8 To use MPEG playback in Microsoft Windows 3.11 , do the following : 
WIN 

1 Open Media Player. 

2 Click on Device. 

3 Do one of the following: 

When you want to play MPEG files, select IBM MPEG-2. 

When you want to play a movie or CD, select 
CD-iWideoCD . 

4 When you want to play a video CD or CD-i movie from the 

CD-ROM drive of your computer, click on the Play ([E] ) icon. 
Otherwise, select the MPEG file you want to play; then click on 

the Play ([B) icon . 

You can also use the IBM Video CD Player program to play a video 
CD or CD-i in Windows. For information on how to use this 
application, Help is available in the Video CD Player screen . 
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Using the Enhanced VideoMPEG Functions 

The following are considerations when using the MPEG playback 
function in Windows 3.11: 

Smart drive caching of the CD-ROM drive 
To be able to play CD-i movies, do not cache the CD-ROM drive 
by the SMARTDRV Version 5.0 or 5.1, which is supplied with PC 
DOS Version 7.0. 

Video CD Player program 

- The chapter-control-related functions might not work with 
some karaoke CDs. 

- Check the following if you do not have enough audio volume 
with the Video CD Player program: 

- The audio volume of the Video CD Player program 

- The WAVE and MASTER volume control of the Mwave 
Audio Control menu 

- The speaker volume control on the computer 

Drive letter for MCf* video CDCD-i and Video CD Player 
To change the drive letter for MCI video CDCD-i and Video CD 
Player: 

1 Select Control Panel from the Main folder. 
2 Select Drivers. 
3 Select [MCI] CD-iWideoCD . 
4 Click on Setup. 
5 Change the drive letter. 
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Using the Enhanced VideoMPEG Functions 

Using the MPEG Playback for Windows 95 

~ The MPEG feature enables hardware to decode MPEG playback 
~ files under playback application programs. 

Important-Before Using Video CDs in Windows 95 ---------------~ 

When you play your video CDs, the playback speed might be slow or playback might stop 
intermittently. To get a smooth playback of video CDs, disable the current CD-ROM driver and 
install the CD-ROM driver for DOSX/Vindows. Do the following : 

1 Start Windows 95. 

2 Disable the 32-bit storage driver: 

a) Select My Computer, Control Panel, and then System. 

b) Click on the Performance tab; then click on the File System button. 

c) Click on the Troubleshooting tab. 

d) Check Disable all 32 bit protect-mode disk drivers. 

e) Click on Apply, OK, and then Close. 

f) Select Yes to the question "Do you want to restart your computer now?' to make the 
change effective. 

3 Install the CD-ROM device driver for DOSX/Vindows: 

a) Insert the ThinkPad CD-ROM Driver Diskette in the diskette drive. 
b} Select Start and Run. 
c) Type A: \ UINSTALL; then click on OK. 
d) Follow the instructions on the screen. 
e) After the installation is complete, remove the diskette; then restart the computer. 

You can play video CDs at a normal speed. 

Note: This procedure might cause the following: 

Some functional restrictions $uch as the auto sense function) 
Decreasing computer performance 
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Using the Enhanced VideoMPEG Functions 

To use MPEG playback in Windows 95, do the following: 

1 Open Media Player. 

2 Click on Device. 

3 Do one of the following : 

When you want to play MPEG files, select IBM MPEG-2. 

When you want to play a movie or CD, select 
CD-iWideoCD . 

4 When you want to play a video CD or CD-i movie from the 

CD-ROM drive of your computer, click on the Play ([E]) icon. 
Otherwise, select the MPEG file you want to play; then click on 

the Play ([E]) icon. 

You can also use the IBM Video CD Player program to play a video 
CD or CD-i in Windows. For information on how to use this 
application, Help is available in the Video CD Player screen . 

The following are considerations when using the MPEG playback 
function in Windows 95: 

CD-i support 
Windows 95 does not support playing of CD-i movies. 

Video CD Player program 

- The chapter-control-related functions might not work with 
some karaoke CDs. 

- If you do not have enough audio volume with the Video CD 
Player program, check: 

- The audio volume of the Video CD Player program 
- The WAVE and MASTER volume control of the Mwave 

Audio Control menu 
- The speaker volume control on the computer 

Drive letter for MCI Video CDCD-i and Video CD Player 
To change the drive letter for MCI video CDCD-i and Video CD 
Player: 

1 Select Control Panel from the My Computer folder. 
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Using the Enhanced VideoMPEG Functions 

2 Click on the Multimedia icon. 

3 Select Advanced. 

4 Click on Media control device. 

5 Click on [MCI] CD-iWideoCD . 

6 Confirm that "Use this Media Control device" is selected; 
then select Settings. 

7 Change the drive letter. 

Using the Video-in Video Capture and Video Overlay) for Windows 
3. 11 and Windows 95 

You can use the capture applications supported by Video for 
Windows** and your computer. You can also overlay motion video 
from the video-in port by using applications supported by MCI 
~edia Control Interface) overlay. 

Notes: 

Only one capture window can be open at a time. 
When you use video capture with the overlay screen on, the 
capturing screen might be distorted . However, the data is 
correctly captured. 

To capture motion video: 

1 Turn off the computer. 

2 Connect the video in-out cable 2 to the video-in port (o) 1 

of the computer; then connect your video equipment. 
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Video Out Audio-Out Left 

S-Video Out / /i 

r\ o t d;o-017' ~- ,.-,,.-,,.~ 
11 "'-

. 
fL 

To microphone jack 
of the computer 

Cables, except for the video in-out cable 2 , are not 
supplied with the computer. 

If you are using video equipment with S-video output, 
connect the S-video port of the video in-out cable to the 
S-video-out connector of your video equipment A for 
better picture quality. 

If you are not using video equipment with S-video output, 
connect the composite video port of the video in-out cable 
and the video-out port of your video equipment B . 

If your video equipment has only one audio output 
connector, use the left-audio connector on the audio cable 
for connection. 

3 Check the Enhanced Video status. 

a) Open the ThinkPad Features program. 

b) Select the Enhanced Video ( ) icon. 

c) If Video captureMPEG status is enabled, go to step 5 on 
page 77. 

If not, continue to the next step. 
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d) Click on Advanced. 

e) Click on the 1st IRQ list box and assign an IRQ for the 
device. (The default IRQ is 11.) 

4 Restart the computer to make the IRQ setting take effect. 

5 Start the video capturing application program. 

If you use the Digital Video Producer (DVP) program, see 
"Using the Digital Video Producer for Windows." 

If you use the Media Player, see "Using the Overlay with 
Media Player for Windows" on page 81. 

Using the Digital Video Producer for Windows 

~ ~ Digital Video Producer (DVP) is an application program that has the 
~ ~ following functions : 

Capturing, compressing, and building a video file 
Capturing a still image (see page 80) 

Capturing, Compressing, and Building a Video File 

This sample procedure describes how to capture a video clip, import 
it in DVP, and build a compressed .AVI file that you can use in a 
presentation and other computer-based materials. The video file 
created in this example has the following characteristics. (You need 
approximately 17MB of hard disk space to capture a video file.) 

Frame size 160 pels by 120 pels 

Frame rate 15 frames per second 

Number of seconds 30 seconds 

Audio sampling rates 8-bit, 11.025 kHz, mono 

Important ------------------~ 

Make sure your video source (such as a VCR or video camera) is 
correctly connected to your computer before you start the video 
capture. If you select overlay mode from the Options menu in 
DVP Capture, you can verify the connection and look at your 
video both before and during the capture. 
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To capture, compress, and build a video file: 

1 Start DVP; then select Video Capture from the Tools menu. 

2 Select Set Capture File from the File menu. 

3 Enter a name for your capture file (such as CAPTURE.AV!) and 
specify the directory in which to save the file; then click on OK. 

4 Select Allocate File Space from the File menu and enter 17MB 
as the hard disk space to set aside for your capture file; then 
click on OK. 

5 Select Audio Format from the Options menu. 

6 Select these sound options: 8-bit, 11 kHz, and Mono. Then 
click on OK. 

7 Select Video Format from the Options menu. 

8 Select 160x120 for Image Dimensions and Overlay YUV422 or 
Compressed YUV422 for Image Format; then click on OK. 

9 Select Video Source from the Options menu, the type of video 
connector your video source uses (video or S-video), and the 
type of video signal (NTSC or PAL). 

To see the supported color standard list of countries, see the 
ThinkPad Features program help. 

10 Select Settings from the Capture menu and specify the 
following options: 

Frame Rate 15 frames per second 

Enable Capture Time Limit 30 seconds 

Capture Storage 

End Capture Using 

Capture to Disk 

Escape Key 

11 Check Capture Audio; then click on OK. 

12 To start the video capture, select Video from the Capture 
menu. 

DVP Capture saves the file with the name you specified in step 
3. You can then save the file to a new name by choosing Save 
Captured File As from the File menu. 
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13 Select Exit from the File menu to close DVP Capture and return 
to DVP. 

DVP automatically imports the video file you just captured and 
displays it in the Media window. 

14 Drag your video clip from the Media window onto the tick bar 
~irectly above the video A track on the timeline). 

Dragging a clip onto the tick bar is an efficient way to lay out 
your clip because the video and audio information in the file 
appears automatically on both the video A and audio A tracks. 
You can also lay out a video clip on the timeline by dragging it 
first from the Media window to a video track, and then from the 
Media window to an audio track. 

15 Select Compression from the Video menu to specify the 
compressioni:lecompression (:;ODEC) routine you want to use. 

16 Select Intel** lndeo·· Video R3.2 for Compressor and accept 
the default values for Key Frame Every and Data Rate ; then 
click on OK. 

17 Select Build from the Video menu. Enter the name and 
location of your final .AVI file (r,aking sure to keep the .AVI 
extension) ; then click on Build. 

The Build Progress dialog box opens, so you can look at the 
percentage-complete bar and the preview window to track the 
progress of the bui ld. Building a video can take anywhere from 
a few minutes to several hours, depending on its length and 
complexity, and on the type of compressor you select. 
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Note: 
Because many paint programs, such 
as Windows Paintbrush , do not yet 
support 16-bit still images, you will 
typically capture 8-bit or 24-bit still 
images. 

Capturing a Still Image 

This section describes how to capture a still image. 

Important ---------------------, 

Be sure your video source (such as a VCR or video camera) is 
correctly connected to your computer before you capture the still 
image. If you select overlay mode from the Options menu in 
DVP Capture, you can verify the connection and look at your 
image before you capture it. 

To capture a still image, whose frame size is 320 pels by 240 pels: 

1 Start DVP; then select Video Capture from the Tools menu. 

2 Select Video Format from the Options menu; then select 320 x 
240 for Image Dimensions and Overlay YUV422 or 
Compressed YUV422 for Image Format; then click on OK. 

For the best color display, make sure that you install and select 
the 65536 (16-bit) video display driver. For detailed information 
about the display driver, see the User's Guide. 

3 Select Video Source from the Options menu; then select the 
type of video connector your video source uses (video or 
S-video) and the type of video signal (NTSC or PAL) for Video 
Standard. Then click on OK. 

To see the supported color standard list of countries, see the 
ThinkPad Features program help. 

4 When the image you want to capture appears in the Preview 
window, select Single Frame from the Capture menu. 

5 Select Save Single Frame from the File menu to save it as a 
bitmap file (with a .BMP extension). 
Using the DVP Help System -----------~ 

To learn more about DVP or DVP capture, use the DVP online 
Help system. 
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Using the Overlay with Media Player for Windows 

To view a video by using the overlay function with Windows Media 
Player, do the following: 

1 Open Media Player in Windows. 

2 Click on Device. 

3 Select MCI OVERLAY Driver. 

Operational Restrictions 
The following shows restrictions when using the Enhanced Video 
functions in Windows 3.11 or Windows 95: 

You can use only one video application at a time-for example, 
you cannot capture video while playing back an MPEG file. 

Some types of video CDs cannot be viewed. 

Video overlay, capture, and MPEG playback functions do not 
work under the following video modes: 

- 1024x 768 resolution, 256 color depth, and 75Hz refresh rate 
- 1024x 768, 65,536, and 75Hz 
- 1280x 1024 and 256 
- All 16 color modes 

Do not select virtual screen in the ThinkPad Features program. 

Video overlay, capture, and MPEG playback functions are not 
supported in virtual screen mode, such as 1024x 768 on an LCD 
or 800x600 on a television. 

For Windows 3. 11 only: When you load QuickTime** for Windows 
as the MCI driver, the MPEG video might not be played correctly. 
To avoid this, open Control Panel in the Main window and click 
on Drivers; then remove QuickTime for Windows from the driver 
list. 
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Installing Software for Windows Version 3.11 

ro7 This section describes the installation procedures for Windows 
~ Version 3.11 and its device drivers for your ThinkPad computer. 

Important ------------------~ 

Before reinstalling the operating system and device drivers, you 
need to create all installation diskettes using the Diskette Factory 
program (a diskette backup program that is preloaded on your 
computer). 

The following shows the software already installed at the time of 
purchase. For your computer to work as it did at the time of 
purchase, install all of this software: 

1 Install DOS Page 185. 

~ Install the CD-ROM device driver for DOS 

Install the ThinkPad Features program for DOS 

Page 186. 

Page 187. 

2 Install Windows 3.11 (with Advanced Power Management) 
Page 190. 

3 Install the ThinkPad display driver Page 193. 

4 Install the ThinkPad Features program for Windows 

5 Install the PC Card Director 

6 Install one of the following: 

Page 194. 

~ Mwave support software 
or 

Page 195. 

Page 194. 

~ ESS AudioDrive support software Page 196. 

7 ~ Install the MIDI Port device driver Page 196. 

8 Install the Infrared device driver Page 197. 

9 ~ Install the Enhanced VideoMPEG device driver and Video CD 

Player Page 197. 
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Installing Microsoft Windows Version 3.11 

Note: 
If you have installed OSQ, the path 
to install Windows may have 
changed to C:\0S2\MDOS\WINOS2 
(C is the drive on which you installed 
OSQ). If so, change the path to: 

C: \ WINDOWS 

Windows 3.11 operates in a DOS environment. Install the following 
before installing Windows: 

DOS Version 7.0 (see your DOS manuals) 

~ CD-ROM Device Driver for DOS (see page 186) 
ThinkPad Features program for DOS (see page 187) 
Important ------------------~ 

During installation, do the following for Windows to operate 
correctly: 

When the Windows Setup program asks you to select either 
Express Setup or Custom Setup, select c for Custom 
Setup. 

Install Windows 3.11 with the default VGA display driver that 
came with Windows. After you complete the installation of 
Windows, install the ThinkPad display driver. 

Do the following to install Windows Version 3.11 with Advanced 
Power Management (APM): 

1 Install Windows Version 3.11 with the APM option: 

a) Start the installation as specified in the Windows manual. 

b} When the Windows Setup program asks you to select 
Express Setup or Custom Setup, type c for Custom 
Setup. 
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Note: 
When Windows Version 3.11 is 
installed , the computer is 
automatically configured to use the 
MOUSE.COM driver provided by 
Windows Version 3.11 . However, for 
correct operation , your computer 
must use the MOUSE.COM driver 
that came with DOS. 

Installing Windows 3. 11 Software 

c) Continue installing Windows Version 3.11 until the following 
screen appears: 

Windows Setup 

Setup has determined that your system includes the followin hardware 
and software components. If your computer or network appear on the 
Hardware Compat i bi l ity List with an asterisk , press Fl for elp. 

Computer: 
Di splay: 
Mouse: 

MS-DOS System 
VGA 
Microsoft, or IBM PS/2 

d) Using the Up Arrow ( ), highlight MS-DOS System and 
press Enter. 

e) Select MS-DOS System with APM from the list and press 
Enter. 

Verify that Computer has changed to MS-DOS System 
with APM. If the item has not changed, return to step 1d. 

2 Make sure the Display: choice is set to VGA. (Do not change 
this choice.) 

3 When you have completed the installation of Windows, edit the 
AUTOEXEC.BAT file so that the computer will use the correct 
mouse driver: 

a) At the DOS command prompt (usually C:\::,, type 
E \AUTOEXEC . BA T and press Enter. 

b) Find the line: C:\WINDOWS\MOUSE.COM 'ff 

c) Change it to: C: \ DOS \MOUSE . COM /Y 

d) Find the line that includes SHARE.EXE and delete that line. 

e) Save the file and restart the computer. 
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4 After installing Windows, you should check the creation date of 
the following drivers in the DOS subdirectory and the Windows 
subdirectory: 

EMM386.EXE (oaded by CONFIG.SYS) 
HIMEM.SYS (oaded by CONFIG.SYS) 
SMARTDRV.EXE (oaded by AUTOEXEC.BAT) 

~ MSCDEX.EXE (oaded by AUTOEXEC.BAT) 

Then use the newest program between the one for DOS and 
the one for Windows for each drivers. 

You can easily use the newer one by changing the subdirectory 
name in the CONFIG.SYS or AUTOEXEC.BAT as follows: 

C: \ WINDOWS \ SMARTDRV.EXE 

C: \ DOS \ SMARTDRV.EXE 

When you start Windows from the DOS prompt, do not close the 
LCD while the program is loading; if you do, the computer will stop 
running. 
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Installing the ThinkPad Display Driver for Windows 3.11 

Note: 
When installing an operating system, 
you need to install the ThinkPad 
display driver. 

Note: 
You can change the display 
resolution type by using the 
ThinkPad Features program after 
completing the installation of the 
ThinkPad Features program for 
Windows. 

Note: 
Cyberxxxx in the right screen 
means: 

For the TFT model: Cyber9385 
For the DSTN model : Cyber9320 

Do the following to install the ThinkPad display driver for Windows 
3.11 so that you can get a correct display setting and a better 
performance: 

1 Start DOS; then go to the WINDOWS subdirectory. 

2 Type SETUP to start the Windows setup program. 

3 Using the Up Arrow ( ), highlight Display and press Enter. 

4 Select Other (Requires disk ... ) from the list. 

5 Insert the Video Features Diskette for Windows into the 
diskette drive; then type A : and press Enter. 

6 Select your desired resolution from the menu and press Enter. 

Verify that Display has changed to your desired resolution type 
(an example is shown in the following screen). If the item has 
not changed, return to step 3. 

Windows Setup 

Setup has determined that your system includes the followin hardware 
and software components. I f your computer or network appear on the 
Hardware Compatibi l ity List with an asterisk, press Fl for elp. 

Computer: 
Display: 
Mouse: 

MS - DOS System with APM 
Cyberxxxx 1 24x768 256 small font 
Microsoft, or IBM PS/2 

7 Press Enter to continue the installation. 

8 After the installation is complete, remove any diskette from the 
diskette drive and restart the computer. 
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Installing the ThinkPad Features Program for Windows 3.11 

Note: 
When installing an operating system, 
you need to install the ThinkPad 
Features program. 

If you are going to use Windows, install the ThinkPad Features 
program for DOS first (see page 187); then do the following to install 
the ThinkPad Features program for Windows 3.11: 

1 Start Windows. 

2 Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the Utility Diskette for Windows into the diskette drive; 
then type A:\ INSTALLW and press Enter. 

4 Follow the instructions on the screen. 

Default choices are already highlighted at the Installation 
Options screen. 

Installing the PC Card Director for Windows 3.11 

Note: When installing Windows 3.11, you need to install the PC Card 
The PC Card Director for Windows Director. You must install the following device drivers and software 
3.11 must be installed with Windows associated with PCMCIA before you can use the PC Cards: 
3.11 or a later version with enhanced 
mode. Otherwise, it cannot be 
installed. 

To use PC Card Director: 

Page 44. 

Card Services device driver 
Socket Services device driver 
Resource Map Utility device driver 
PC Card Power Management device driver 
PC Card Director Utility 
PC Card client device drivers (only when PC Card Director does 
not support the PC Card) 

To install the PC Card Director: 

1 Start Windows. 

2 Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the PC Card Director Diskette for DOS and Windows into 
the diskette drive; then type A: PCMINSTW and press Enter. 
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4 Follow the instructions on the screen to complete the 
installation. 

Default choices are already highlighted at the choice screens. 

5 After the installation is complete, remove any diskette from the 
diskette drive and restart the computer. 

Installing the Mwave DSP Support Software for Windows 3.11 

~ To install the Mwave DSP support software: 

1 Start Windows. 
Note: 
When installing an operating system, 
you need to install the Mwave DSP 
support software. 

Attention: 
Before you install the Mwave DSP 
support software, close all open 
applications. 

2 Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the Mwave DSP Features Diskette 1 for Windows into 
the diskette drive; then type A: SETUP and press Enter. 

4 Follow the instructions on the screen. 

Default choices are already highlighted at the choice screens. 

5 After the installation is complete, remove any diskette from the 
diskette drive and restart the computer. 

Note -------------------~ 

Non-U.S. users must run the Country Selection program in 
the Mwave window after the Mwave installation is complete. 
Restart the computer after you run Country Selection. 

If this is your first time to install the Mwave DSP support software for 
Windows, also install the MIDI sample files as follows: 

6 Follow the same procedures from step 2 to step 5; however, 
use the MIDI Samples Diskette 1 instead of the Mwave DSP 
Features Diskette 1 for Windows. 

7 After the installation is complete, remove any diskette from the 
diskette drive and restart the computer. 
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Installing the MIDI Port Device Driver for Windows 3.11 

~ To use the MIDI port, when connecting a MIDI keyboard device or 
external synthesizer, install the Mwave MIDI Port device driver: 

1 Select the Control Panel from the Main window in the Windows 
Program Manager; then select Drivers. 

2 Select Add ... ; then select Unlisted or Updated Driver. 

3 Select OK. 

4 Type c: \MWW \MIDIPORT and select OK. 

MIDIPORT is the subdirectory name where you have installed the 
Mwave DSP support software. 

5 Select Mwave MIDI Port Driver; then select OK. 

Installing the ESS AudioDrive Support Software for Windows 
3.11 

~ To install the AudioDrive support software: 
~ 

1 Start Windows. 

2 Select File ... from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the AudioDrive Features Diskette for Windows into the 
diskette drive of your computer; then type A: \S ETUP and press 
Enter. 

Follow the instructions on the screen to complete the 
installation. 
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Installing the Infrared Device Driver for Windows 3.11 

Note: To install the infrared device driver: 
When installing an operating system, 
you need to install the Infrared 
device driver. 

1 Start Windows; then insert the Infrared Features Diskette into 
the diskette drive. 

2 Go to the DOS command prompt; then type A:UINSTALL and 
press Enter. 

The following screen appears: 

Installation Options 

Installation Source Drive 

Type the SOURCE drive letter (A-Z). When you install a program, the 
SOURCE drive letter is the location you are installing FROM. 

Source Drive .. . [ ml 

Enter F1 =Help F3=Exit 

3 Press Enter; then follow the instructions on the screen. 

Select Install Windows ThinkPad lnfraRed Driver when you 
are asked. 

Installing the Enhanced VideoMPEG Device Driver and the 
Video CD Player for Windows 3.11 

To use the Enhanced Video functions in Windows 3.11, you must 
install the ThinkPad display driver (Cyber. .. ) and the Mwave DSP 
support software before installing the Enhanced Video device 
drivers. 

Installing the Video OverlayCapture Device Driver for Windows 3. 11 
The Video OverlayCapture device driver enables the video in-out 
port on Video for Windows or compatible software. Install Video for 
Windows or compatible software; then do the following to install the 
video overlaytapture device driver: 

1 Start Windows. 
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2 Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the MPEGX/ideo Capture Driver Diskette for Windows 
into the diskette drive; then type A: SETUP and press Enter. 

Follow the instructions on the screen. 

4 After the installation is complete, remove the diskette and 
restart the computer to activate the Video OverlayCapture 
device driver. 

To run the video capture and playback functions, refer to the Video 
for Windows or compatible software manuals. To install the MPEG 
device driver, proceed to the following section. 

Installing the MPEG Device Driver for Windows 3. 11 
The MPEG device driver enables playback for MPEG motion videos, 
CD-i movies, and video CDs. 

Important -------------------~ 

If this is not your first time installing the MPEG device driver for 
Windows 3.11 , remove IBM MPEG-2 and CD-iWideoCD from the 
Installed Driver list in the Drivers menu. 

To install the MPEG device driver: 

1 Install the Microsoft Win32s** driver: 

a) Start Windows. 

b) Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

c) Insert the Microsoft Win32s Setup Diskette 1 into the 
diskette drive; then type A: \ SETUP and press Enter. Follow 
the instructions on the screen. 

d) After you have completed the installation, restart Windows. 

2 Click on Control Panel from the Main window. 

3 Click on Drivers; then click on the Add button. 

4 Select Unlisted or Updated Driver; then click on OK. 
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5 Insert the MPEG Features Diskette for Windows into the 
diskette drive of the computer. 

6 Make sure the drive letter is A: ; then click on OK and follow the 
instructions on the screen. 

Install all the drivers listed by repeating steps 2 on page 198 to 
6. After you have completed the installation, restart Windows. 

Installing the IBM Video CD Player for Windows 3. 11 
The IBM Video CD Player for Windows enables playback of video 
CDs or CD-i movies with more options than with the Media player: 

1 Start Windows. 

2 Select File from the Program Manager window; then select 
Run ... from the pull-down menu. 

3 Insert the Video CD Player Install Diskette into the diskette 
drive; then type A : SETUP and press Enter. 

Follow the instructions on the screen. 
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Installing Software for Windows 95 

Eij This section describes the installation procedures for Windows 95 
and its device drivers for your ThinkPad computer. 

Important ------------------~ 

Before reinstalling the operating system and device drivers, you 
need to create all installation diskettes using the Diskette Factory 
program (a diskette backup program that is preloaded on your 
computer). 

The following shows the software already installed at the time of 
purchase. For your computer to work as it did at the time of 
purchase, install all of this software: 

1 Install Windows 95 Page 201. 

2 Install the ThinkPad display driver Page 201. 

3 Install the ThinkPad Features program Page 203. 

4 Install the PC Card Director 

s Install one of the following: 

Page 204. 

~ Mwave support software Page 207. 
or 

~ ESS AudioDrive support software Page 208. 

6 Install the Infrared support software Page 209. 

7 ~ Install the CD-ROM device driver Page 210. 

s Install the Enhanced videoMPEG device driver and Video CD 

Player Page 212. 

Also, if you use the docking station, see page 214 and page 215. 
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Installing Microsoft Windows 95 

Install Windows 95 as described in its documentation. 
To Avoid Problems While Installing --------~ 

If you encounter a problem while installing Windows 95, refer to 
the following: 

If the screen blacks out during installation , do the following : 

1. When the screen blacks out, wait until the hard disk 
activity stops (until the hard disk indicator disappears); 
then restart the computer. 

2. Start the Windows 95 setup from the beginning . 

3. On the Safe Recovery screen of the Windows 95 Setup 
Wizard, select Use Safe Recovery tecommended) ; 
then click on the Next> button. 

4. On the Setup Options screen of the Windows 95 Setup 
Wizard, select Custom; then click on the Next> button. 

5. On the Analyzing Your Computer screen of the Windows 
95 Setup Wizard, select Yes, redetect now; then click 
on the Next> button. 

Follow the instructions to complete the installation of 
Windows 95. 

If you encounter Unknown Hardware Fo und messages durin 
installation, select Do not install a driver fJindows will 
not prompt you again). 

Installing the ThinkPad Display Driver for Windows 95 

To install the ThinkPad display driver for Windows 95, do the 
following: 

1 Start Windows 95. 

2 Open My Computer, Control Panel, and System; then click 
on the Device Manager tab. 
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3 Click on the + mark for Display adapters. 

4 Click on the Trident** Super VGA, and click on the Remove 
button. Click on OK when prompted to remove the device. 

5 Select No when prompted to restart Windows 95. 

Windows 95 will restart. 

6 Click on the + mark for Other devices. 

7 Click on PCI VGA-Compatible Display Adapter and click on 
the Properties button. 

8 Click on the Driver tab, and click on the Change driver button. 

9 In the Select Hardware Type dialog, select Display adapters 
and click on OK. 

10 Insert the Video Features Diskette for Windows 95 into the 
diskette drive; then click on the Have Disk button and click on 
OK. 

11 Make sure the following is shown as the selection: 

For TFT model: IBM ThinkPad ~yber938582) PCI 
For DSTN model: IBM ThinkPad ~yber9320) PCI 

Then click on OK. 

12 Click on OK to install the driver into the computer. 

13 When prompted to restart, click on Yes; then remove the 
diskette from the drive and restart Windows 95. 
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Note: 
If you are attaching an external 
monitor and not sure what to choose, 
select Super VGA 1280x1024. 
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If you want to change the monitor type, screen resolution , or color 
depth, do the following: 

14 Move the mouse pointer to the desktop and click the right 
mouse button. 

When pop-up menu appears, select Properties. 

15 In the Display Properties window, click on the Setting tab; 
then click on the Change Display Type button. 

16 Click on the Change button in the Monitor Type box. 

17 If you are attaching an external monitor, select the appropriate 
monitor from the list. If not, select Laptop Display Panel 
~ 024x768) or Laptop Display Panel ~00x600) . 

18 Click on OK; then click on Close. 

19 In the Desktop area box, drag the slider to the appropriate 
resolution, such as 1024 by 768 pixels; then click on OK. 

20 Select your favorite color depth {or example, 256 color) from 
the Color palette. 

21 When prompted to resize the desktop, click on OK. 

The desktop size $creen resolution) changes. 

Installing the ThinkPad Features Program for Windows 95 
The ThinkPad Features program for Windows also works for 
Windows 95. 

If you installed Windows 95 on a computer in which DOS, 
Windows, and the ThinkPad Features program were already 
installed, the ThinkPad Features program is migrated into the 
"Start Menu" of Windows 95 automatically. 

To start the ThinkPad Features program: 

1 Click on Start; then select Programs. 

2 Select ThinkPad; then select ThinkPad Features. 

If you installed Windows 95 on a blank hard disk or if you have 
not installed the ThinkPad Features program, install the 
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ThinkPad Features program using the Utility Diskette for 
Windows supplied with the computer: 

1 Insert ThinkPad Utility Diskette for Windows into the 
diskette drive. 

2 Click on Start; then click on Run .... 

3 Type a : INS TALLW and click on OK. 

Follow the instructions on the screen. 

Installing the PC Card Director for Windows 95 

Note: 
The ThinkPad computer has three 
different sets of PCMCIA Feature 
software: one for DOSWindows, one 
for OS~ Warp, and one for Windows 
95. 

Note: 
CardBus PC Cards cannot be used 
in Windows 95. 

The following is a summarized procedure to use the PCMCIA 
features in Windows 95 ~ach step is explained in detail later): 

1. If you have already installed the PC Card Director for DOS and 
Windows, disable it ~nable the Windows 95 Integrated PCMCIA 
support software). 

2. Install the Socket Services device driver. 

3. Install the PC Card Director for Windows 95. 

Disabling the PC Card Director for DOS and Windows 
If the PC Card Director for DOS and Windows has been already 
installed on your computer, you must remove the PC Card Director 
for DOS and Windows before installing the PCMCIA support software 
for Windows 95. This is because the Windows 95 installation 
program does not automatically remove the PC Card Director for 
DOS and Windows. 

To remove the PC Card Director for DOS and Windows, do the 
following (his procedure also enables the Windows 95 Integrated 
PCMCIA support software): 

1 Start Windows 95; then select My Computer, Control Panel, 
and then PC Card. 

2 Select No for the question "Are you using a PC card to install 
Windows? and click on Next. 
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3 Select No for the question "Do you want to review your system 
files and select real-mode PC card drivers so Windows can 
disable them?' and click on Finish. 

4 Complete the Windows 95 PCMCIA support setup; then restart 
your computer. 

You have removed the PC Card Director for DOS and Windows. To 
install the ThinkPad PC Card Director for Windows 95, do the 
following section. 

Installing the Socket Services Device Driver 
Prepare your Windows 95 product diskettes or CD-ROM, if you do 
not already have the Windows 95 integrated PCMCIA support 
software installed on your computer. 

To install the ThinkPad Socket Services device driver for Windows 
95: 

1 Start Windows 95; then select My Computer, Control Panel, 
and then System. 

2 Click on the Device Manager tab. 

3 Click on the + mark for PCMCIA socket. 

4 Double-click on PCIC or compatible PCMCIA controller. 

5 Click on the Driver tab to see the Driver files: list. 

6 Click on the Change Driver ... button. 

7 Click on the Have Disk ... button. 

8 Insert the PC Card Director Diskette for OS2 and Windows 95 
into the diskette drive; then click on the OK button. 

You will see the "PCIC or compatible PCMCIA controller on 
IBM system" item in the "Models:" list. 

9 Click on the OK button. 

IBMCSS01.VXD and IBMPCDIF.VXD will be listed in the Driver 
files: list. 
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Note: 
These files were copied when you 
installed the Windows 95 integrated 
PCMCIA support software. 

10 Click on the OK button. 

Windows 95 now starts copying files. The Insert Disk panel 
asks for one of the Windows 95 installation diskettes or the 
CD-ROM. 

11 Change the source for Copying files from: to A:\ when 
Windows 95 tries to copy IBMCSS01.VXD or IBMPCDIF.VXD. 

12 Insert the PC Card Director Diskette for OS2 and Windows 95 
into the diskette drive; then click on OK. 

IBMCSS01.VXD and IBMPCDIF.VXD are copied from the 
diskette. 

13 Click on the OK button at the Insert Disk panel. 

14 Click on the Skip File button at the Copying Files ... panel when 
Windows 95 tries to copy the following files: 

CARDDRV.EXE 
CSMAPPER.SYS 
FLS1 MTD.VXD 
FLS2MTD.VXD 
PCCARD.VXD 
SRAMMTD.VXD 

15 Restart the computer. 

Installing the PC Card Director for Windows 95 
To install the PC Card Director for Windows 95, do the following: 

1 Start Windows 95; then open My Computer, Control Panel, 
and then AddRemove Programs. 

2 Click on the Install. button. 

3 Insert the PC Card Director Diskette for OS2 and Windows 95 
into the diskette drive; then click on the Next> button. 

4 Click on the Finish button when you see "A:\INSTALLP.EXE" 
on the screen. 

5 Click on the Continue button when the opening panel of the 
installation program appears on the screen. Follow the 
instructions on the screen. 
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Installing the Mwave DSP Support Software for Windows 95 

~ Do one of the following: 

If you are installing the Mwave DSP support software for 
Windows for the first time, you need to install Mwave DSP 
support software for Windows 95 and MIDI sample files. 

If you have already installed the Mwave DSP support software 
for Windows, you need to install only the Mwave DSP support 
software. You do not need to install the MIDI sample files. 

Installing the Mwave DSP Support Software 
To install the Mwave DSP support software: 

1 Start Windows 95; then click on Start, and then Run .... 

2 Insert the Mwave DSP Features Diskette 1 for Windows 95 into 
the diskette drive; then type A: SETUP and press Enter. 

The Mwave installation window appears and prompts you to 
input the destination directory for the software. If the default 
directory is OK, press Enter. Otherwise, type a directory name 
and press Enter. 

Follow the instructions on the screen. 

3 If you are installing the Mwave DSP support software for the 
first time, go to "Installing the Mwave MIDI Sample Files" on 
page 208 and follow the instructions. Otherwise, remove any 
diskette from the diskette drive and restart Windows 95. 

Note --------------------~ 

Non-U.S. users must run the Country Selection program in the 
Mwave window after the Mwave installation is complete. Restart 
the computer after you run Country Selection. 
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Encounter a problem? 

If you encounter a problem when using the Mwave DSP features 
for Windows 95 after installation, verify that "C:\MWW\DLL" is 
included in the PATH statement of AUTOEXEC.BAT. 

Installing the Mwave MIDI Sample Files 
To play MIDI files on your computer, install the Mwave MIDI sample 
files as follows: 

1 Start Windows 95; then click on Start, and then Run .... 

2 Insert the MIDI Samples Diskette 1 into the diskette drive; then 
type A : SETUP and press Enter. 

The Mwave installation window appears and prompts you to 
input the destination directory for the software. If the default 
directory is OK, press Enter. Otherwise, type a directory name 
and press Enter. 

3 Follow the instructions on the screen. After the installation is 
completed, remove any diskette from the diskette drive; then 
restart Windows 95. 

Installing the AudioDrive Support Software for Windows 95 

~ When you install Windows 95, it might detect the AudioDrive chip 
ESS installed in your computer, and automatically install the required 

audio software in your hard disk drive. However, the version of the 
AudioDrive support software supplied with Windows 95 might be an 
earlier version than the one needed for your computer. 

In any case, you should reinstall the AudioDrive support software as 
follows: 

1 Start Windows 95; then open My Computer. 

2 Click on Control Panel and then System to open the System 
Properties window. 

3 Click on the Device Manager tab; then double-click on Sound, 
video, and game controllers from the list. 
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4 Double-click on ESS AudioDrive; then click on the Driver tab. 

5 Click on the Change Driver button; then click on the Have 
Disk ... button. 

6 Insert the AudioDrive Features Diskette for Windows 95 into the 
diskette drive; then type A: and click on OK. 

If an error message appears on the screen, do steps 7 to 9. If the 
installation begins without any problem, go to step 10. 

7 Click on OK until you see the following message: 
Insert Disk [2J 

Q$) Please insert the disk labeled 'Install Disk 1', and then click OK. 

~ 

8 Make sure the AudioDrive Features Diskette for Windows 95 is 
inserted in the diskette drive; then click on OK. 

9 Type A: at the Copy Files From window; then click on OK. 

10 After the installation is complete, click on the Close button. 

Installing the Infrared Device Driver for Windows 95 
To install the infrared device driver for Windows 95, do the following : 

1 Start Windows 95; then go to the MS-DOS command prompt. 

2 Insert the Infrared Features Diskette into the diskette drive; then 
type A: UINSTALL and press Enter. 

3 At the Installation Options screen, press Enter to accept the 
default source drive. 

Follow the instructions on the screen. 

4 Select Install Windows ThinkPad Infrared Driver when you 
are asked. 

Make sure you specify the directory where you have installed 
Windows 95 when asked. 

To make sure that the infrared port is configured correctly, do the 
following : 
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1 Start Windows 95 and select My Computer. 

2 Click on Control Panel and then System. 

3 Click on the Device Manager tab; then see if the Generic lrDA 
Compatible Device node has (:OM1) or (:OM2) . 

If not, do the following: 

a) Go to the MS-DOS command prompt. 

b) Type edit c : \windows \ inf \ mspo rts . inf and press Enter. 

c) Locate the following line: 

% PNP 51 .Devi ceDesc% =NoDrv , PNP 51 

Change this line to: 

% PNP 51 .Devi ceDesc% =CornPort , PNP 51 

d) Save the changed file and exit the MS-DOS command 
prompt. 

e) In the Device Manager panel, click on Generic lrDA 
Compatible Device node. 

f) Click on Remove and then Yes to remove this node 
temporarily. 

g) Click on Refresh, then Yes to register this node using the 
new port definition . 

h) Restart Windows 95. 

Installing the CD-ROM Device Driver for Windows 95 

~ This section describes how to disable unnecessary DOSWindows 
-@ CD-ROM device driver. 

If you installed Windows 95 on a blank hard disk drive without 
DOS and Windows, Windows 95 has automatically installed a 
generic ATAPI CD-ROM device driver for your ThinkPad's 
CD-ROM drive. You do not need to do the following procedure. 
Go to "Installing the Enhanced VideoMPEG Device Driver and 
the Video CD Player for Windows 95" on page 212. 
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Note: 
The default subdirectory for 
C:\xxxxxx is C:\CDROM. 

Note: 
The default subdirectory for 
C:\xxxxxx is C:\CDROM. 
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If you installed Windows 95 in a computer on which DOS and 
Windows had been already installed, you need to disable the 
DOSX/1/indows CD-ROM device driver to use the correct 
Windows 95 generic ATAPI CD-ROM device driver. 

To disable the DOSX/1/indows CD-ROM device drivers: 

1 Start Windows 95 and go to the MS-DOS command prompt. 

2 Open the CONFIG.SYS file; then find the following line: 

DEVI CE=C:\xxxxxx\ IBMTPCD. SYS / R 

xxxxxx is the subdirectory where you have installed the 
CD-ROM device driver. If you cannot find the line , quit the file 
and go to step 4. 

3 Comment out the line to change it as follows: 

REM DEVICE=C:\xxxxxx\ IBMTPCD.SYS / R 

If the line is already commented out, quit the file and go to the 
next step. 

4 Open the AUTOEXEC.BAT file; then find the following line: 

C:\xxxxxx\MSCDEX.EXE / D:TPCD 1 /M: 15 

xxxxxx is the subdirectory where you have installed the 
CD-ROM device driver. If you cannot find the line , quit the file 
and go to step 6. 

5 Comment out the line to change it as follows: 

REM C:\xxxxxx\MSCDEX.EXE / D:TPCD 1 /M: 15 

If the line is already commented out, quit the file and go to the 
next step. 

6 Exit the DOS command prompt; then reboot the system. 
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Installing the Enhanced VideoMPEG Device Driver and the 
Video CD Player for Windows 95 

To use the Enhanced Video functions in Windows 95, you must 
install the ThinkPad display driver (Cyber ... ) and the Mwave DSP 
support software before installing the Enhanced Video device 
drivers. 

Installing the Video Overlay.Capture Device Driver for Windows 95 
The Video OverlayCapture device driver enables the video in-out 
port and Video for Windows (a standard component in Windows 95) 
or its compatible software. 

To install the Video OverlayCapture device driver for Windows 95: 

1 Start Windows 95; then click on My Computer, Control Panel, 
and then Add New Hardware. 

2 Click on Next>; then select No to the question Search for your 
new hardware?. 

3 Click on Next>; then select Sound, video, and game 
control le rs. 

4 Click on Next>; then click on Have Disk. 

5 Insert the MPEGX/ideo Capture Driver Diskette for Windows 95 
into the diskette drive; then select OK. 

6 Install all the drivers listed on the screen. 

You cannot install multiple drivers at the same time. 

7 After the installation is complete, remove the diskette from the 
diskette drive. 

8 Restart the computer to make the video overlaytapture device 
driver effective. 

To use the video capture and playback functions, refer to the 
Windows 95 documentation or your video captureplayback software 
manual. 
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To install the MPEG device driver, proceed to the following section. 

Installing the MPEG Device Driver for Windows 95 
The MPEG device driver enables playback for MPEG motion video, 
CD-i movies, and Video CDs on your computer. To install the MPEG 
driver for Windows 95: 

1 Start Windows 95; then click on My Computer. 

2 Click on Control Panel and then Add New Hardware. 

3 Click on Next>; then select No to the question Search for your 
new hardware? 

4 Click on Next>; then select Sound, video and game 
controller. 

5 Click on Next>. 

6 Insert the MPEG Features Diskette for Windows 95 into the 
diskette drive; then click on Have Disk .... 

7 Highlight IBM MPEG CD-iWideoCD (nci) ; then click on OK. 

8 Click on OK; then click on Finish. 

9 Click on Finish. 

10 When Windows 95 prompts you to restart the computer, click 
on No, and repeat steps 2 to 9 to install IBM MPEG 
FileslSO9660 (nci), by selecting IBM MPEG FileslSO9660 
(nci) in step 7. 

11 When Windows 95 prompts you to restart the computer, click 
on No, and repeat steps 2 to 9 to install IBM MPEG PCI Bridge 
by selecting IBM MPEG PCI Bridge in step 7. 

If this is the first installation of the IBM MPEG PCI Bridge, you 
must do the following once. This procedure removes the device 
from the unknown class and adds it to the sound, video, and 
game controllers. 

a) Select Control Panel, System, and then Device Manager. 
b) Select Other Devices and PCI Multimedia Device. 
c) Select Remove; then click on OK. 

12 Shut down Windows 95 and restart the computer. 
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Installing the IBM Video CD Player for Windows 95 
The IBM Video CD Player application enables the playback of video 
CDs and CD-i movies with more options than the Windows 95 
standard Media Player. To install the IBM Video CD Player: 

1 Start Windows 95; then click on the Start button and click on 
Run .... 

2 Insert the Video CD Player Install Diskette into the diskette 
drive; then type A: SETUP and press Enter. 

Follow the instructions on the screen. 

Disabling the Docking Control Program 

Note: 
To open the WIN.INI file, type EDIT 

WIN. INI and press Enter. 

All docking functions, once provided by the ThinkPad Docking 
Control Utility program for Windows, are now supported by the 
ThinkPad Plug-and-Play BIOS and Windows 95. 

If you have installed Windows 95 on a computer in which the 
Docking Control Utility for Windows had already been installed, stop 
this utility program from working as follows: 

1 Open the WIN.INI file using your editor; then remove the 
following statement: 

[windows] 

load=C: \ THINKPAD \ DOCKWIN.EXE Remove this statement 

2 Save and close the file. 

3 Open the SYSTEM.IN! file using your editor; then remove this 
statement: 

[386Enh] 

device=IBMPNP.386 Remove this statement 

4 Save and close the file; then restart Windows to make the 
changes effective. 
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Using Windows 95 with the Dock II 
When you use the Dock II with your computer and Windows 95, you 
need to disable the host adapter SCSI BIOS for Dock II. You can 
disable the host adapter SCSI BIOS by using either the Dock II 
SCSISelecr· utility or the DIP switches in the Dock II : 

Using the Dock II SGS/Select Utility 
1 Attach your computer to the Dock II and turn on the computer. 

2 Press and hold the Ctrl key; then press the A key when 
prompted at boot time. 

3 Select ConfigureWiew Host Adapter Settings and disable the 
Host Adapter BIOS. 

Using the DIP Switches in the Dock II 
To use the DIP switches, refer to the section "Using the SCSI 
controller'' in the Dock II User's Guide. 
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